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3X zoom, 14
10X zoom, 14-15
35mm equivalent, 15

o/ o

Action mode
for animal subject, 97
at big event, 93
description of, 12, 64
Add Items option
(Windows DVD
Maker), 300, 302
address label, 28
Adobe Photoshop
Elements, 132
AF Illuminator, 54-55
AF (Auto Focus) mode,
54-55
all-in-one printer, 228
Alt key (Windows Live
Photo Gallery), 197
Analyze button (Adjust
Detail option), 219
angles, shooting from
unexpected, 76-78
animal, as subject, 97-98
antishake feature, 15-16,
67
Aperture option (Info
pane), 169
Aperture priority mode,
116, 118-119

aperture size
Automatic mode and,
111-112
controlling, 118-119
importance of, 113
lighting and, 115
measurement of, 114
shutter speed and,
115-116
archival quality photo
paper, 229
Arrange by button
(Windows Live Photo
Gallery), 176
arrow keys, 37, 46
Ascending button
(Windows Live Photo
Gallery), 176
aspect ratio
description of, 51-52
of digital picture frame,
281-282
Attach files dialog box
(Windows Live Photo
Gallery), 254-255
attaching photo to
e-mail, 253-256
audio, recording video
and, 41
author, e-mail address
of, 4
Author option (Info
pane), 168
Auto adjust option (Fix
menu), 206

Auto Focus (AF) mode,
54-55
Automatic (Auto) mode
aperture size, shutter
speed, and, 111-112
at big event, 93
flash and, 74
menu choices in, 47-48
using, 32-34
automatic scene mode, 8
AutoPlay dialog box
(Windows Live Photo
Gallery), 152-153
auto-review setting, 57

ol o

background, including or
excluding, 71
backing up photos,
187-190
Backlight mode, 65
backup software, 188
bag, for camera, 23
battery
installing, 27
types of, 13, 23
battery charger, 23
battery power for digital
picture frame, 284
Beach mode, 100-101
Beep setting, 49-50
big event, planning
photos at, 92-94
bird, as subject, 95-97
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Black and white (B&W)
mode, 121
black and white photo
shooting, 123-124
turning color photo
into, 215-217
book of photos, creating
online
book style, 308
Collect Pictures screen,
311, 313-314
Edit Pages screen,
314-316
Join Shutterfly screen,
310-311
Organize Pictures
screen, 313, 315
overview of, 307-318
paper pattern, 309
Preview book screen,
317
Quantity and Recipients
screen, 317-318
reviewing, 316
Upload Pictures screen,
311-312
book, Web site for, 4
bracketing, 118, 123
bridge camera
description of, 9-10
modes, 117
zoom lens of, 14
brightness
digital picture frame
and, 282, 289
of scene, 62
brightness setting for
LCD and electronic
viewfinder, 56-57
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Brightness slider,
208-209, 211
bug, extreme close-up of,
94-95
Burn a Disc dialog box
(Windows Live Photo
Gallery), 242
Burn button (Windows
DVD Maker), 304
burning data CD,
242-243
Burst mode
description of, 34
landscape photo
and, 101
portraits and, 82
buying
accessories, 22-25
memory card, 16-17, 22
printer, 227-229
buying camera
features, deciding on,
11-18
price range, 10-11
researching on Web,
18-20
in store, 20-22
types of, 8-10
B&W (Black and white)
mode, 121

oo

cable
to connect camera to
printer, 231
to connect computer
and camera, 150-152
description of, 22
for printer, 228-229

calendar, on digital
picture frame, 284
camera
printing directly from,
231
setting up, 25-28
types of, 8-10
Camera option (Info
pane), 168
caption, creating, 167
card reader, 23
Casio camera, compact,
point-and-shoot, 8
CD
copying photo to,
241-243
printing from, at in-
store kiosk, 243-244
CD-R compared to CD-
RW, 241
center focus, 16
center-point focus, 120
center-weight metering,
119
Change default autoplay
options (Windows
Live Photo Gallery),
150
Cheat Sheet, 18
Choose the programs you
want to install dialog
box (Windows Live
Photo Gallery),
135-136
city scene, 106-108
clock, on digital picture
frame, 284, 289
Clock setting, 48-49
close-up, extreme, of
flower or bug, 94-95
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close-up setting, 13-14
CNET Web site, 11, 19
Collect Pictures screen
(Shutterfly), 311,
313-314
color, adjusting, 214-217
Color mode, 121
color photo, turning into
black and white,
215-217
Color temperature slider,
214-215
compact, point-and-
shoot camera, 8
composing photo
landscape shot, 102
overview of, 68-70
panorama, capturing,
and, 109
shooting from
unexpected angles,
76-78
computer
as accessory, 25
copying photos directly
from camera to,
150-154
copying photos from
memory card to,
155-156
copying photos from, to
digital picture frame,
291-293
desktop background,
turning photo into,
296-297
finding photos on,
175-177
printing from, 232-237

screen saver, turning
photo into, 297-300
setting up and
connecting printer to,
229-230
viewing photos
onscreen, 158-161
configuring Windows
Live Photo Gallery,
144-150
contact, adding in Flickr,
274-275
Contact sheet option
(Print Pictures dialog
box), 233-234
Contacts menu (Flickr),
275
context menu, Send To
option, 188-189
contrast ratio, and digital
picture frame, 282,
289
Contrast slider, 209-211
controls. See also manual
controls
for digital picture frame,
283-284
locating, 30-31
for slideshow, 165-166
copy (Ctrl+C), 156
Copy button (Windows
Vista), 204
copying folder for
backup, 188
copying photo
for backup, 189
to CD, 241-243
from computer to
digital picture frame,
291-293

directly from camera to
computer, 150-154
to flash drive, 241
from memory card to
computer, 155-156
Create Your Account
button (Flickr), 261
crescent moon symbol,
101, 106
cropping
description of, 183-184
photo for digital picture
frame, 290
printing and, 239-240
steps in, 193-195
Ctrl+0 (fit to window),
219
Ctrl+A (select all), 156
Ctrl+C (copy), 156
Ctrl+P (print), 232
Ctrl+R (revert), 202
Ctrl+V (paste), 156, 177
Ctrl+X (cut), 156, 177
Ctrl+Y (redo), 199
Ctrl+Z (undo), 199
cut (Ctrl+X), 156, 177

o) e

date, changing, 48-49

Date Imported + Name
option (Windows Live
Photo Gallery), 145

Date Taken + Name
option (Windows Live
Photo Gallery),
145-146, 149

Date Taken option (Info
pane), 168
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Date Taken Range + Name
option (Windows Live
Photo Gallery), 146

Date Taken, searching by,
175

deep depth of field, 114

Delete button, 31, 38

Delete files from device
after importing
option (Windows Live
Photo Gallery), 149

deleting photo

from camera, 38-39

from computer,
162-163

from digital picture
frame, 291

depth of field, 114-116

Descending button
(Windows Live Photo
Gallery), 176

description, adding

on Flickr, 268
to photo, 167-169
desktop background,
turning photo into,
296-297

Details pane (Windows
Explorer), 180

Details view (Windows
Live Photo Gallery),
142

digital picture frame

changing settings,
288-289

copying photos from
computer to, 291-293

description of, 279
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editing photos for,
290-291
memory card,
displaying photos
from, 287-288
selecting, 280-286
setting up, 286-287
digital single-lens reflex
(DSLR) camera
description of, 9
modes, 117
dimensions of screen of
digital picture frame,
281
Dimensions option (Info
pane), 168
diopter correction knob
or wheel, 13
Display button, 32
displaying
index of thumbnails,
36, 43
metadata in Windows
Explorer, 180-181
distractions, excluding, 71
dock, for camera, 231
document, adding photo
to, 304-306
down button, 46-47
Download complete
dialog box (Windows
Live Photo Gallery),
135
Downloading
information from the
Internet dialog box,
248, 250-251
DSLR (digital single-lens
reflex) camera

description of, 9
modes, 117
DVD slideshow, creating,
300-304

of o

ease of use, 12
Edit Pages screen
(Shutterfly), 314-316
Edit=>Copy (Word), 304
Edit=>Cut (Word), 304
editing photo
backing up before,
187-190
color, adjusting,
214-217
cropping, 183-184,
193-195
for digital picture frame,
290-291
exposure, correcting,
205-213
in-frame, and digital
picture frame, 284
making copy, 191-192
red-eye, removing,
196-197
reverting to original
photo, 200-204
selecting photo,
190-191
sharpening, 217-219
stitching panorama
shots together,
221-223
straightening, 219-221
undoing and redoing
changes, 197-200



Index

editing software, 183. See
also Windows Live
Photo Gallery
Edit>Paste (Word), 304
electronic viewfinder
brightness setting,
56-57
description of, 12-13
switching display from
LCD to, 30
e-mail
attaching photos to,
253-256
resizing photos for,
256-259
enabling Red-Eye
Reduction, 56
Erase after importing
option (Windows Live
Photo Gallery),
153-154
Estimated time left dialog
box (Windows Live
Photo Gallery), 135
event, planning photos
at, 92-94
EXIF (exchangeable
image file), 179
Explorer (Windows)
Include Folder in Gallery
option, 179
metadata, displaying in,
180-181
moving photo using,
177-178
undeleting or restoring
photo using, 164
viewing photos in, 156
viewing photos using,
161

exposure
adjusting further,
207-213
correcting, 205-207
definition of, 62, 112,
205
Exposure compensation
function, 122
Exposure option (Info
pane), 168
external hard drive,
backing up photos to,
188

o[ e

Face Recognition/
Detection function,
12, 81, 83

Facebook, 260

features, deciding on

common, 12-13
intermediate, 13-18

File Download-Security
Warning dialog box
(Windows Live Photo
Gallery), 133-134

file format, 17

File name option
(Windows Live Photo
Gallery), 147-149

file type, selecting, 52-54

Filem>Include a Folder in
the Gallery (Windows
Live Photo Gallery),
178

File>Make a Copy,
191-192

Filename option (Info
pane), 167

Filec>Print (Word), 306
FilevSave (Word), 306
File>Screen Saver
Settings (Windows
Live Photo Gallery),
297-298
fill flash, 74
Filter By option
(Windows Live Photo
Gallery), 176
finding photo on
computer, 175-177
Fireworks mode, 100-101
Fit Picture to Frame
option (Print Pictures
dialog box), 234-237
Fit to Window (Ctrl+0),
219
Fix pane (Windows Live
Photo Gallery)
Adjust Color option,
214-215
Adjust Detail option,
217-218
Adjust Exposure option,
207-208
Auto adjust option, 206
Black and White Effects
option, 215-217
Brightness slider,
208-209, 211
Contrast slider, 209-211
Fix red eye option, 196
Highlights slider,
210-212
histogram, 212-213
Proportion list, 194
Shadows slider, 210-211
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Fix pane (Windows Live
Photo Gallery)
(continued)

showing or hiding,
190-191
Straighten Photo
option, 219-221
flash
at big event, 94
effective range of, 74
outdoors, 72
portraits and, 82
slow-synchro, 94, 106
turning on and off,
34-35
using, 73-74
Flash control, 30, 35
flash drive
backing up photos to,
188-189
copying photos to, 241
digital picture frame
and, 285
printing from, at in-
store kiosk, 243-244
Flash mode
landscape photo and, 101
portraits and, 82-83
flexible-point focus,
120-121
Flickr
contacts, adding,
274-275
description of, 260
home page, 263
Mail link, 274
organizing photos on,
267-269
pro account, 265
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setting up account,
261-263
sharing photos with
family and friends,
269-271
sharing photos with
groups, 271-274
tracking recent activity
on, 276-277
uploading photos to,
263-267
flowers
extreme close-up of,
94-95
field of, photographing,
116-117
Focal length option (Info
pane), 169
focal point
depth of field and, 116
landscape photo and, 99
focus
areas of, 67
description of, 62-63
landscape photo and, 99
on subject, 66-68
Focus mode, 16, 120-121
folder
adding to Photo Gallery,
178-179
copying for backup, 188
searching in, 175
Folder name option
(Windows Live Photo
Gallery), 144-147
forced flash, 74, 82
foreground, including or
excluding, 71
Format Memory Card
option, 57

Format Picture~Size
(Word), 305
Format setting, 53-54
frame. See digital picture
frame
framing photo
landscape shot, 102
overview of, 68-70
panorama, capturing,
and, 109
shooting from
unexpected angles,
76-78
frequency of photo
change on digital
picture frame, 289
f-stop, 114
Full page photo option
(Print Pictures dialog
box), 233
function guide, 48

o (G o

Gallery view (Windows
Live Photo Gallery),
184-186

glossy photo finish, 248

Google Photos, 260

Google Picasa

description of, 3,
131-132
installing, 138

green triangle in green
square symbol, 36

group portrait, shooting,
91-92

grouping photos, 177

Groups=Search for a
Group (Flickr),
271-272
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hard drive, external,
backing up photos to,
188

head symbol, 64

help feature, 48

High sensitivity mode, 65

Highlights slider, 210-212

histogram, 212-213

How do I change my
import settings? link
(Windows Live Photo
Gallery), 150

o] e

image sensor, 16

image size, setting, 50-52

image stabilization
feature, 15-16

Import Photos and
Videos dialog box
(Windows Live Photo
Gallery)

Add tags option, 170

Import Photos and Videos
dialog box (Windows
Live Photo Gallery),
153-154

Import tab (Windows
Live Photo Gallery),
144-145, 149-150

indoor light, 124-125

Indoor mode, 65

indoors, using natural
light, 72-73

Info pane (Windows Live
Photo Gallery)

Add Descriptive Tag
option, 171
changing information
in, 167-169
opening, 141
viewing photos onscreen
and, 158-159
inkjet printer, 228
Insert=>Shapes (Word),
306
installing
memory card, 25-26
Picasa, 138
Windows Live Photo
Gallery, 133-138
in-store kiosk, printing
from, 243-244
iPhoto, 132-133
ISO mode, 65-66,
122-123
ISO option (Info pane),
169

° ] °

Join Shutterfly screen
(Shutterfly), 310-311

Join This Group link
(Flickr), 272

JPEG file, 17, 53

oK o

keyboard shortcuts
Ctrl+0 (fit to window),
219

Ctrl+A (select all), 156
Ctrl+C (copy), 156
Ctrl+P (print), 232
Ctrl+R (revert), 202
Ctrl+V (paste), 156, 177

Ctrl+X (cut), 156, 177
Ctrl+Y (redo), 199
Ctrl+Z (undo), 199
kiosk, in-store, printing
from, 243-244

o/ o

labeling camera, 28
Landscape mode
aperture size and, 116
depth of field and, 115
description of, 64-66,
100
landscape orientation,
64, 85
landscape photo
city scene, 106-108
focus and, 99
at night, 105-106
panorama, capturing,
108-110
settings for, 100-101
at sunrise or sunset,
103-105
taking, 102-103
Landscape plus Portrait
mode, 64
laser printer, 228
LCD screen
brightness setting,
56-57
description of, 12-13
Display button and, 32
gridlines on, 69
switching from
viewfinder to, 30
leading lines, 69-70
left button, 46-47
lens cover/cap, 27, 32
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light conditions
aperture size, shutter
speed, and, 115
indoor light, 124-125
natural light, 72-73
light sensitivity, 122-123
lightning bolt symbol,
35, 67, 82-83
liquid crystal display
screen. See LCD
screen
Live Photo Gallery
(Windows). See also
Navigation pane
Alt key in, 197
attaching photo to
e-mail, 253-256
burning data CD,
242-243
color, adjusting,
214-215
configuring, 144-150
cropping photo,
193-195
deleting photo,
162-163
description, adding to
photo, 167-169
description of, 2-3,
130-131
Details view, 142
exposure, fixing,
205-213
File name option,
147-149
FileroMake a Copy,
191-192
folder, adding to,
178-179
Folder name option,
144-147
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Gallery view, 184-186

Import tab, 144-145,
149-150

Info pane, 141, 158-159,
167-169, 171

installing, 133-138

menu items, 140-141

moving photo, 177-178

Navigation pane,
158-159, 170-171

People tags, 173-174

Photo Gallery screen,
139-140

Preview view, 184-185,
187

printing from, 232-237

properties of photos,
examining, 179-181

red-eye, removing,
196-197

resizing photos for
e-mail, 256-259

reverting to original
photo, 200-202

rotating photo, 161-162

saving changes when
editing, 195

Screen Saver Settings
dialog box, 297-298

search box, 175

selecting photo to edit,
190

Set as desktop
background option,
296-297

sharpening photo,
217-219

slideshow, watching,
165-166

starting, 139

stitching panorama
shots together,
221-223

straightening photo,
219-221

Tab key in, 208

tags, adding to photos,
169-174

Thumbnail view, 143

undeleting photo,
164-165

undoing editing change,
197-200

View button, 142

viewing photos
onscreen, 158-161

o U o

Macro mode, 94
Make=>Burn a DVD
(Windows Live Photo
Gallery), 300-301
Make>Create Panoramic
Photo (Windows Live
Photo Gallery), 222
manual controls
Aperture priority mode,
118-119
bracketing, 123
Color mode, 121
Exposure compensation,
122
Focus mode, 120-121
ISO mode, 122-123
Metering mode,
119-120
Shutter priority mode,
117-118
White Balance, 121
manual focus, 16, 121
Manual mode, 117
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manufacturers of
cameras, Web sites
of, 20
matte photo finish, 248
megapixels, 16
memory card
copying photos to
computer from,
155-156
description of, 16-17
displaying photos from,
on digital picture
frame, 287-288
installing, 25-26
printing directly from,
231
printing from, at in-
store kiosk, 244
removing, 26
size of image and space
on, 51
spare, having on hand,
22
memory card reader,
155-156
memory card slot in
digital picture frame,
282
memory, internal, of
digital picture frame,
283
Menu button
Delete option, 38-39
setup menu, 46
menu items (Windows
Live Photo Gallery),
140-141
menu options,
consistency of, 47
merger, 71
metadata, 179-181

Metering mode, 119-120
Microsoft. See also
Windows Explorer;
Windows Live Photo
Gallery
Live Photos, 260
Word document, adding
photo to, 304-306
WordArt, 306
Mode dial, 46
modes. See also
Automatic (Auto)
mode; Landscape
mode; Portrait mode;
Sports mode
Action, 12, 64, 93, 97
Aperture priority, 116,
118-119
Auto Focus (AF), 54-55
automatic scene, 8
Backlight, 65
Beach, 100-101
Black and white (B&W),
121
Burst, 34, 82, 101
Color, 121
Fireworks, 100-101
Flash, 82-83, 101
Focus, 16, 120-121
High sensitivity, 65
Indoor, 65
ISO, 65-66, 122-123
Landscape plus Portrait,
64
Macro, 94
Manual, 117
Metering, 119-120
Movie, 39-41, 48
Night scene, 65-66
Night sky, 100-101,
105-106

Panorama, 100-101, 109
Party, 65
Program, 117
Review, 48
Scene (SCN), 65-66, 100
scene, 12, 63-66
Sepia color (§), 121
Shutter priority, 116
Smile Shutter, 66
Snow, 100-101
Twilight, 64
Vivid color (V), 121
monopod
city scene and, 108
description of, 24
More Servicesw>Publish
on Flickr (Windows
Live Photo Gallery),
263
mountain peaks symbol,
64
movement of camera
while shooting video,
40
Movie mode
options, 48
video, shooting, 39-41
moving
crop box, 194
photo, 177-178
multiple spot focus, 16
multi-point focus, 120
multi-point metering, 119
Myspace, 260

o\ o

Name + Date Imported
option (Windows Live
Photo Gallery), 147
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Name + Date Taken
option (Windows Live
Photo Gallery), 147,
149

Name + Date Taken
Range option
(Windows Live Photo
Gallery), 147

Name option (Windows
Live Photo Gallery),
147-148

natural light, 72-73

Navigation pane
(Windows Live Photo
Gallery)

Descriptive Tags option,
170-171

example of, 140

Gallery view and,
184-186

viewing photos onscreen
and, 158-159

netbook, 286

Night scene mode, 65-66

Night sky mode

landscape photo and,
100-101

night photo and, 106

night, taking photo at,
105-106

Nikon camera, DSLR, 9

noise, reducing, 218

None option (Windows
Live Photo Gallery),
147

number of copies,
choosing to print, 234

o () o

OK button, 37, 46-47
online review, 18-19
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Open Windows Live
Photo Gallery after
importing files
option, 149

opinion-sharing Web site,
20

optical zoom, 15

order of photos on digital
picture frame, 289

Order Prints dialog box,
246

ordering prints online,
239, 244-252

Organize Pictures screen
(Shutterfly), 313, 315

Organizet»New Folder,
156

organizing photos

on Flickr, 267-269
software for, 129-133

Original File Name
option (Windows Live
Photo Gallery), 148

Original File Name
(Preserve Folders)
option (Windows Live
Photo Gallery), 149

overexposure, 62

o pPoe

panning, 159
panorama, capturing,
108-110
Panorama mode
description of, 100-101
framing photo in, 109
panorama shot, stitching
together, 109-110,
221-223
paper, archival quality,
229

Paper size option (Print
Pictures dialog box),
236

Paper type option (Print
Pictures dialog box),
236

Party mode, 65

paste (Ctrl+V), 156, 177

PC Magazine Windows
Vista Solutions, 161

People tags, 173-174

perspective, changing,
76-78

Photo Book, creating
online

book style, 308

Collect Pictures screen,
311, 313-314

Edit Pages screen,
314-316

Join Shutterfly screen,
310-311

Organize Pictures
screen, 313, 315

overview of, 307

paper pattern, 309

Preview book screen,
317

Quantity and Recipients
screen, 317-318

reviewing, 316

Upload Pictures screen,
311-312

photo editing software,
183. See also Windows
Live Photo Gallery

Photo Gallery. See
Windows Live Photo
Gallery

Photo Gallery screen
(Windows Live Photo
Gallery), 139-140
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photo organizing
software
choosing, 130-133
description of, 129
photo sharing service
choosing, 260-261
contacts, adding,
274-275
organizing photos on,
267-269
setting up account,
261-263
sharing photos with
family and friends,
269-271
sharing photos with
groups, 271-274
tracking recent activity
on, 276-277
uploading photos to,
263-267
Photo size option (Attach
files dialog box),
254-255
photostream page
(Flickr), 266-267
Picasa (Google)
description of, 3,
131-132
installing, 138
PictBridge standard, 231
picture frame, digital
changing settings,
288-289
copying photos from
computer to, 291-293
description of, 279
editing photos for,
290-291
memory card,
displaying photos
from, 287-288

selecting, 280-286
setting up, 286-287
picture quality, setting,
50-52
pixels, 16
planning photos at big
event, 92-94
playing slideshow,
165-166
point-and-shoot
camera, 8
Popular link (Flickr), 277
portrait
casual, shooting, 87-88
definition of, 79
group, shooting, 91-92
posed, shooting, 84-86
self-portrait, snapping,
88-90
settings for, 80-84
Portrait menu item, 80
Portrait mode
aperture size and, 116
depth of field and, 115
description of, 12, 64,
66, 80
group shot and, 91
landscapes and, 100
options, 85
portrait orientation
description of, 64, 85
landscape photo and,
103
Portrait symbol, 80
Power button, 30-31
power-saving setting, 57
preparing photo for
printing, 240-241
Preview book screen
(Shutterfly), 317

Preview button (Screen
Saver Settings dialog
box), 299

Preview view (Windows
Live Photo Gallery),
184-185, 187

price range for camera,
10-11

Print Pictures dialog box
(Windows Live Photo
Gallery), 232-236

Print Test Page button,
230

printer. See also printing

as accessory, 25

buying, 227-229

setting up and
connecting to
computer, 229-230

Printer option (Print
Pictures dialog box),
235

Printer= Properties, 230

printing. See also printer

from computer,
232-237

cropping and, 239-240

directly from camera or
memory card, 231

from in-store kiosk,
243-244

ordering prints online,
244-252

preparing photos for,
240-241

Word document, 306

Print=>Order Prints
(Windows Live Photo
Gallery), 244-245

Print=Print, 232
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privacy notice when
ordering prints
online, 246

Program mode, 117

properties of photo,
examining, 179-181

prosumer camera, 9-10

Publish on Flickr dialog
box, 264-265

o () o

Quality option (Print
Pictures dialog box),
236

Quantity and Recipients
screen (Shutterfly),
317-318

o R e

Rathbone, Andy, Windows
Vista For Dummies,
161
Rating option (Info
pane), 168
RAW file, 17, 53
RAW+JPEG file, 54
Ready to Burn Disc screen
(Windows DVD
Maker), 302-303
rechargeable battery,
13, 23
rectangle stack symbol, 82
red X symbol, 163
Red-Eye Reduction
description of, 18
enabling, 56
flash and, 74
portraits and, 82
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red-eye, removing in
Photo Gallery,
196-197
redo (Ctrl+Y), 199
Redo button (Windows
Live Photo Gallery),
198, 200
Reduce Noise slider,
217-219
Remove Items option
(Windows DVD
Maker), 300, 302
removing
memory card, 26
red-eye, 196-197
tag from photo, 171
repositioning photo in
text, 306
researching cameras on
Web, 18-20
Resize dialog box
(Windows Live Photo
Gallery), 256-257
resizing
crop boxes, 194
photos for digital
picture frame,
290-291
photos for e-mail,
256-259
photos in Word
document, 304-306
resolution of screen of
digital picture frame,
281
Restore defaults option
(Windows Live Photo
Gallery), 150
Restore This Item button
(Windows Explorer),
164

restoring photo, 164-165
reverting to original
photo, 200-204
Review button, 31,
36-37, 57
Review mode, 48
reviewing photos
on camera, 36-38
in online book, 316
right button, 46-47
Rotate photos during
import option
(Windows Live Photo
Gallery), 149
rotating photo
on computer, 161-162
for digital picture frame,
290
Rule of Thirds, 68-69
running stick figure
symbol, 64

oS e

S (Sepia color) mode, 121
Saturation slider,
214-215
saving
changes when editing,
195
Word document, 306
Scene mode (SCN)
landscape photo and,
100
menu options, 65
selecting, 66
Scene Mode dial, 30
scene modes, 12, 63-66
scenery, taking photo of
city scene, 106-108
focus and, 99
at night, 105-106
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panorama, capturing,
108-110
settings for, 100-101
at sunrise or sunset,
103-105
taking, 102-103
screen of digital picture
frame, 281
Screen Saver Settings
dialog box (Windows
Live Photo Gallery),
297-298
screen saver, turning
photo into, 297-300
search options, 175-176
select all (Ctrl+A), 156
selecting photo to edit,
190-191
self-portrait, snapping,
88-90
Send To option (context
menu), 188-189
Sending pictures to the
printing company
dialog box, 252
Sepia color (S) mode, 121
Set as desktop
background option
(Windows Live Photo
Gallery), 296-297
sets, adding on Flickr,
269
setting up camera, 25-28
setup menu options,
46-48
Shadows slider, 210-211
shallow depth of field,
114
Share this photo dialog
box (Flickr), 270-271

sharing photo
with family and friends,
269-271
with Flickr Groups,
271-274
Sharpen slider, 217-218
sharpening photo,
217-219
shooting video, 39-41
shortcuts
Ctrl+0 (fit to window),
219
Ctrl+A (select all), 156
Ctrl+C (copy), 156
Ctrl+P (print), 232
Ctrl+R (revert), 202
Ctrl+V (paste), 156, 177
Ctrl+X (cut), 156, 177
Ctrl+Y (redo), 199
Ctrl+Z (undo), 199
Shuffle Contents option
(Screen Saver Settings
dialog box), 299
Shutter priority mode, 116
Shutter Release button
Auto mode and, 33-34
description of, 30-31
location of, 21
shutter speed
aperture size and,
115-116
Automatic mode and,
111-112
importance of, 112-113
lighting and, 115
setting, 117-118
Shutterfly, creating Photo
Book on
book style, 308
Collect Pictures screen,
311, 313-314

Edit Pages screen,
314-316
Join Shutterfly screen,
310-311
Organize Pictures
screen, 313, 315
overview of, 307-318
paper pattern, 309
Preview book screen,
317
Quantity and Recipients
screen, 317-318
reviewing, 316
Upload Pictures screen,
311-312
size. See also aperture size;
resizing
of image, setting, 50-52
of photo, choosing to
print, 233-234
Size option (Info pane),
168
Slide Show Speed option
(Screen Saver Settings
dialog box), 299
Slideshow button, 42
slideshow, DVD, creating,
300-304
slideshow, watching,
165-166
slow-synchro flash, 94,
106
Smile Detection function,
81
Smile Shutter mode, 66
Snow mode, 100-101
Sony camera, bridge type,
10
sound, controlling,
49-50
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speakers, audio, for
digital picture frame,
284
special effects features, 18
Sports mode
for animal subject, 97
description of, 12, 64,
66
shutter speed and, 116
spot metering, 120
Start>Computer, 164
starting
Info pane (Windows
Live Photo Gallery),
167
Microsoft Word, 304
Windows Explorer, 164
Windows Live Photo
Gallery, 139
Start=>Pictures, 156
Start= Printers, 230
stitching panorama shots
together, 109-110,
221-223
store, looking for camera
in, 20-22
straightening photo,
219-221
subject of photo
animals, 97-98
birds, 95-97
context and, 71
description of, 62
flowers or bugs, 94-95
focusing on, 66-68
portraits and, 79
submitting photo to
Flickr Group,
273-274
sunrise or sunset, photo
at, 103-105

338

o e

T (Zoom/Telephoto)
button, 36-38
Tab key (Windows Live
Photo Gallery), 208
tag
adding on Flickr, 269
adding to photos,
169-174
description of, 157
searching by, 175
telephoto lens, 14
10X zoom, 14-15
test page, printing, 230
text, flowing around
photo in document,
305-306
Text Wrappingt>Square
(Word), 305
Text Wrapping=Top and
Bottom (Word), 305
35mm equivalent, 15
3X zoom, 14
Thumbnail view
(Windows Live Photo
Gallery), 143
thumbnails, description
of, 157
thumbnails, displaying
index of
on camera, 36
onTV, 43
TIF or TIFF file, 54
time, changing, 48-49
time of day, and natural
light, 72-73
timer settings, portraits
and, 83-84
Tint slider, 214-215
title, adding on Flickr,
268

tracking recent activity on
Flickr, 276-277
transition effects, and
digital picture frame,
289
tripod
night shot and, 105
panorama, capturing,
and, 108
selecting, 23-24
using, 74-76
turning camera on and
off, 32
turning flash on and off,
34-35
TV, viewing photo or
video on, 41-43
Twilight mode, 64

o lf o

ultrazoom camera, 14
undeleting photo,
164-165
underexposure, 62, 104
undoing editing change,
197-200
up button, 46-47
Upload Pictures screen
(Shutterfly), 311-312
uploading photo to
Flickr, 263-267
USB connection,
150-151
USB flash drive
backing up photos to,
188-189
copying photos to, 241
digital picture frame
and, 285
printing from, at in-
store kiosk, 243-244
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Use All Photos and
Videos from Windows
Live Photo Gallery
option (Screen Saver
Settings dialog box),
297

Use Photos and Videos
from option (Screen
Saver Settings dialog
box), 298

Use This Theme option
(Screen Saver Settings
dialog box), 298

User Account Control
dialog box (Vista),
135-136

user rating, 18

o/ o

V (Vivid color) mode,
121
vibration reduction
feature, 15-16
video
shooting, 39-41
viewing on TV, 41-43
video format, and digital
picture frame, 285
Video In connection,
41-42
Video Out connection, 41
View button (Windows
Live Photo Gallery),
142
viewfinder
brightness setting,
56-57
description of, 12-13
switching display from
LCD to, 30

viewing
photos onscreen,
158-161
photos or videos on TV,
41-43
viewing angle, and digital
picture frame, 283
Vista (Windows)
backup software, 188
resources on, 161
reverting to original
photo, 202-204
running screen saver in,
300
search box, 177
User Account Control
dialog box, 135-136
Vivid color (V) mode,
121

o[/ o

W (Wide) button, 36-37
Wait option (Screen Saver
Settings dialog box),
300
Walgreens, ordering
prints online from,
245-252
Wallet option (Print
Pictures dialog box),
233
wallpaper, turning photo
into, 296-297
WB (White Balance)
function, 121,
124-125
Web sites
for book, 4
camera and feature
review, 18-20
CNET, 11, 19

digital picture frame
reviews, 280
photo sharing services,
260
Picasa, 131
Shutterfly, 307
sunrise and sunset
times, 104
Windows Live Photo
Gallery, 133
Welcome to Windows
Live! dialog box
(Windows Live Photo
Gallery), 138
White Balance (WB)
function, 121,
124-125
Wide (W) button, 36-37
wide-angle shot, 14-15
Windows DVD Maker,
300-304
Windows Explorer
Include Folder in
Gallery option, 179
metadata, displaying in,
180-181
moving photo using,
177-178
undeleting or restoring
photo using, 164
viewing photos in, 156
viewing photos using,
161
Windows Live Photo
Gallery. See also
Navigation pane
Alt key in, 197
attaching photo to
e-mail, 253-256
burning data CD,
242-243
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Windows Live Photo

Gallery. (continued)

color, adjusting,
214-217

configuring, 144-150

cropping photo,
193-195

deleting photo,
162-163

description, adding to
photo, 167-169

description of, 2-3,
130-131

Details view, 142

exposure, fixing,
205-213

File name option,
147-149

FileroMake a Copy,
191-192

folder, adding to,
178-179

Folder name option,
144-147

Gallery view, 184-186

Import tab, 144-145,
149-150

Info pane, 141, 158-159,
167-169, 171

installing, 133-138

menu items, 140-141

moving photo, 177-178

People tags, 173-174

Photo Gallery screen,
139-140

Preview view, 184-185,
187

printing from, 232-237

properties of photos,
examining, 179-181

340

red-eye, removing,
196-197

resizing photos for
e-mail, 256-259

reverting to original
photo, 200-202

rotating photo, 161-162

saving changes when
editing, 195

Screen Saver Settings
dialog box, 297-298

search box, 175

selecting photo to edit,
190-191

Set as desktop
background option,
296-297

sharpening photo,
217-219

slideshow, watching,
165-166

starting, 139

stitching panorama
shots together,
221-223

straightening photo,
219-221

Tab key in, 208

tags, adding to photos,
169-174

Thumbnail view, 143

undeleting photo,
164-165

undoing editing change,
197-200

View button, 142

viewing photos
onscreen, 158-161

Windows Vista
backup software, 188
resources on, 161

reverting to original
photo, 202-204
running screen saver in,
300
search box, 177
User Account Control
dialog box, 135, 136
Windows Vista For
Dummies (Rathbone),
161
wireless connectivity, and
digital picture frame,
286
Word document, adding
photo to, 304-306
WordArt (Microsoft), 306

o X o

X symbol, red, 163

o(/eo

You're almost done!
dialog box (Windows
Live Photo Gallery),
137

o o

Zoom control, 46
zoom lens, 14-15
zooming
at big event, 94
depth of field and, 116
landscape photo and,
102-103
onscreen, 159-160
while recording video, 40
on wildlife, 98
Zoom/Telephoto (T)
button, 36-38



